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Introduction to Microsoft Word 2010
Handout from Lodi Memorial Library
(Developed by Barb HauckMah for ESL Tech Literacy Grant; Modified by Jennifer
Cohen Feb. 2015)

What is Microsoft Word?
Microsoft Word is a computer software program
that has many tools for typing and editing documents with text, images,
tables, and graphics for printing and sharing.

What we will learn in Intro to Word
HOW TO:
● Open and save Word files
● Change the size, style, and color of the text
● Correct mistakes
● Copy and paste text
● Set paper layout, margins, and line spacing
● Change text alignment
● Create a bulleted list and add a border
● Insert special characters
● Print a document

How to open Word
1. Click the Start button in bottom left corner of computer screen.
2. Point to 
Programs 
or 
All Programs
.
3. Scroll to find 
Microsoft Office
in program list and
4. Click on 
Microsoft Word 2010
to open.
TIP Right click Microsoft Word 2010 on Microsoft Office menu and click on 
Pin to Start
Menu
or 
Create Shortcut
. Now Word will be in the start menu or on your desktop,
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respectively. You can just click on it to open (you’ll need to doubleclick it if it’s a
desktop shortcut; buttons in the start menu only need to be clicked once).

When you open Word, a new blank document opens.
It is an empty white page and the 
Home
tab is open.

How to enter text
See a blinking line cursor? 
|
Start typing and letters will appear to the left of the blinking
line. When you reach the end of a line, Word automatically starts on a new line.

To put spaces between words,
hit the 
spacebar 
on the keyboard.
To start typing on a new line,
hit the 
Enter 
key on the keyboard.
To type a capital letter 
(for example: A, instead of a), hold 
Shift 
key on the keyboard
as you type the letter.
To type a symbol 
(found on the upper half of certain keys on the keyboard), hold 
Shift
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key on the keyboard as you hit the number/symbol key.
To type in ALL CAPITAL LETTERS
, click the Caps Lock key. Click the Caps Lock key
again to turn Caps Lock off and return to normal typing.

How to move around the page(s)
There are two scroll bars available in Word. One, which is always visible is the vertical
scroll bar, which is on the right side of the screen. This scroll bars helps you move up
and down the page(s). To scroll down, hit 
↓
key on keyboard. To scroll up, hit 
↑
key on
keyboard.

The other scroll bar is only available when the page(s) is(/are) placed in the landscape
orientation, which makes the page(s) wider. The horizontal scroll bar, which is on the
bottom of the screen, then becomes visible. To scroll left, hit 
←
key on your keyboard.
To scroll right, hit 
→
key on your keyboard. You can also drag the scroll bar in the
direction you want to move around the page(s).

Practice 1 Type a Word Document
Type the text in the box below.

Practice 2: How to highlight text in Word
1. Put the 
|
cursor to the left or right of the words you want to
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select.
2. Put your pointer finger on the left button on the mouse.
3. Hold down the left button on the mouse.
4. Move the mouse across the words you want to select.
5. Release your finger from the left button on the mouse.
6. You will notice that the text you selected is now
highlighted with a greyishblue color.
7. If you want to get rid of the highlighting, click on a white part
of the screen. This will stop the highlighting; the
greyishblue color will go away.

Change, Delete, and Copy Text

The Undo arrow can undo a mistake.
If you click the wrong button or make a typing error, click the Undo
icon, which is found in the top left corner of the screen and is in the
shape of a small, blue arrow pointing left. It will go back and undo the
last thing you did (or more than that if you press it more than once) if you haven’t saved
the file.

How to delete and change text
● Move the
|
cursor to the right of the text you want to delete. Use the 
Backspace
key to delete one letter at a time. You can then retype new text.
● If you want to delete larger amounts of text, highlight all of the text that you wish
to delete and then press the Backspace key.

How to insert text
Move the
|
cursor to the left of of where you want to insert text. You can then type new
text.
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How to Copy and Paste text
1. Highlight the text that you wish to copy.
2. Click the right button on your mouse and a
menu will pop up.
3. Click the 
Copy 
option in the menu.
4. Move the 
|
cursor to the location on the
page(s) where you want to move the text.
5. Click the right button on your mouse again and the previous menu will pop back
up.
6. Click the 
Paste 
option in the menu this time. There will now be two copies of the
text

How to Cut and Paste text
1. Highlight the text that you wish to copy.
2. Click the right button on your mouse and a menu will pop up.
3. Click the 
Cut 
option in the menu. This will cause the highlighted text to
disappear.
4. Move the
|
cursor to the location on the page(s) where you want to move the text.
5. Click the right button on your mouse again and the previous menu will pop back
up.
6. Click the 
Paste 
option in the menu this time. The cut text will reappear in the new
location.

Practice 3: Edit the Document
Using the Word document created in Practice 1
1. Highlight and change Fax Number to (8885551234)
2. Highlight and delete FAX COVER SHEET. Change to Resume Attached.
3. Insert the sentence See you soon. before Thank you!
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4. Copy and paste all the text.
BONUS: Try to cut and paste one line of text.

Save a new Word file

How to save a file for the first time
1. Click the 
File
tab in the top left corner of the screen.
2. Choose the 
Save as
option from the File menu.
3. A popup menu of 
My Documents 
will open.
4. Click in 
File
name

box towards bottom of popup menu.
Highlight the words that are already in the box before
deleting them. Then type in what you actually want to call
the file.
5. If you know you’re going to be opening this file on a
computer that has a Microsoft Word version that came out
before 2010 or if you’re not sure what version the computers you’ll be using to
open it has, you’ll want to choose Word 972003 Document from the 
Save as
type
drop down menu, found right below the File name box. This will save the file
as a .doc file, which can be opened by computers with Word software from
19972007. Word 2010 regularly saves documents as a .docx file, which can only
be opened by computers that have Word 2010 installed.
6. Click
Save 
button. A copy of this file is now saved in your My Documents folder.
7. The name you’ve given your file can now be seen at the very top of the screen.

How to save a file once it’s already been named
1. Click the 
File
tab in the top left corner of the screen.
2. Choose the 
Save 
option from the File menu.
How to exit Word
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Click the X button in the right corner of the screen (it should turn red when you
roll your mouse over it).

How to open an existing Word File
1. Once in Word, click on the 
File
tab and then the 
Recent
option on the menu.
This will bring up a list of your recent documents. You can then click on one of
the files on the list to open it.
2. If you have not used the file you want to open recently, you will have to click on
the 
Open
option rather than the Recent option on the menu. The My Documents
menu will open and you can choose the file you want by doubleclicking on it.

Practice 4: Save, exit, and open a Word document
1. Save the document that you edited in
Practice, using “fax of resume” as the file
Name.
2. Exit Microsoft Word.
3. Open Word again the same way you did the first time. Note that a new, blank
document will appear on the screen.
4. Find the Word document that you saved and then open it.

How to format text
In Word, it is easy to change text’s style, size, and color.

For all changes when formatting text
● Check that the 
Home
tab is selected. This tab contains the 
Font
menu box.
● Text must be highlighted in order for the new formatting to take effect.
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Example 1: Change font style
1. Click arrow to the right of the 
Font Style
text box.
2. Dropdown menu that shows what text will look like appears.
3. Select a different font style.

Example 2: Change font size
1. Click arrow to the right of the 
Font Size
menu.
2. Dropdown menu that shows what text will look like appears.
3. Click number of font size you want (for example: 14).

Example 3: Change font color
1. Click arrow to the right of the Font menu box to open the 
Font
menu.
2. Dropdown menu will appear with different color options.
3. Click the square showing the color that you want or click 
More Colors 
towards
bottom of the dropdown box.

More text format choices
Clicking on 
B
changes highlighted text to 

BOLD
.
Clicking on 
I
changes highlighted text to 

Italic
.
Clicking on 
U
underlines highlighted text.

You can mix and match these options. For text that is bold, italicized, and underlined,
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click all 3 boxes. Once you’re done with the options, just click the boxes again. Once the
boxes are no longer chosen, the text you type will have normal formatting.

Practice 5: Format the text
1. Open the Word document from Practice 4.
2. Highlight all of the text and change the font style to one of your choice.
3. Highlight only the first line and change the font size to 24.
4. Highlight any 2 lines and change the color of the text to green.
5. Highlight Thank you! and put it in 
italics.
Format paragraphs
● Check that the 
Home
tab is selected. This tab contains the 
Paragraph
menu
box.
● Text must be highlighted in order for the new formatting to take effect.

Example 1: Align text
Default alignment of text is to the left. To align text to the center of the page, click the
Center
button in the 
Paragraph 
menu. To align text to the right of the page, press
Align Text Right 
button.
Example 2: Line spacing

Default spacing between lines is single spacing. For more space between lines, open
the 
Paragraph
menu. Select 
1.5 
or 
2.0 
in 
Line Spacing
menu.
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Example 3: Lists
1. In 
Home
tab, find lists above the Paragraph menu.
2. Click on either the 
Bullets 
option (three black squares
with three horizontal lines to the right of them) or the
Numbering
option (the numbers 1, 2, and 3 with three
horizontal lines to the right of them).
3. Begin the list by typing a single item.
4. To move on to the next item, press 
Enter
. A new line with a new bullet or number
will be created for the next item. Continue doing this until you have finished your
list.
5. When done with your list, click 
Enter
one more time to start a new line and then
click on the 
Bullets 
or 
Numbering
option in the Paragraph menu again. This will
allow you to begin typing normally again.

Example: Grocery List
Bullets Option
● Milk
● Eggs
● Bread
● Bananas
Numbering Option
1. Milk
2. Eggs
3. Bread
4. Bananas

Format page(s)
For all changes when formatting page(s)
Check that the 
Page Layout 
tab is selected. You do not need to highlight text when
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formatting the page(s). These are changes to the whole Word document.

Example 1: Page margins
The default margins are 1 inch all around on the top, bottom, and sides of the page. If
you want a different type of margin:
1. Find 
Page Setup
menu.
2. Click 
Margins 
button in Page Setup menu.
3. You can choose from one of the margin options Word gives you or create your
own by clicking on 
Custom Margins
.
4. If using a Custom Margin, use the menu arrows to increase or decrease the
margin sizes.

Example 2: Page Layout
Click Orientation button in Page Setup menu. You will then be given the option to

change page layout menu from vertical

Example 3: Add a page border
1. Find 
Page Background
menu.
2. Click 
Page Borders
button.
3. A popup box will appear with a menu
that will allow you to choose the style,
size, and color of your page border.

to horizontal

or vice versa.
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Practice 6: Format a document
1. Open the document from Practice 5.
2. Create a customized margin of 1.25” for the left and right of the page and 0.5”
inches for the top and bottom of the page.
3. Set Page Orientation to Landscape.
4. Align the first line of text to the center of the page.
5. Add a page border of your choice
6. Create a bulleted list of 3 people. Remember to only have one person per line.

How to insert special characters or symbols
Word documents can include pictures, tables, WordArt, and special characters like ©.
The 
Symbol 
button has a large selection of such special characters. To access it, click
on the 
Insert 
tab at the top of the page. Now look to the right of the Insert tab to see the
Symbols 
menu, which includes the Symbol button

Practice 7: Insert symbols
1. Open up a new Word document and click on the Insert tab.
2. Type Copyright © 2010
3. Type €104 ≥ €50
4. Try inserting some fun symbols. Click on 
More Symbols
and scroll down the
Font drop down menu towards the upper left of the box. Choose Wingdings from
the list. Here are some examples of Wingding symbols.

BONUS: Insert today’s time and date into your document. Look for the 
Text
menu in the
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Insert tab. Click 
Date & Time
button. A popup menu of different options for writing the
date and time will come up. Once you choose, press 
Okay
.
How to proofread and translate
The 
Review 
tab has grammar, definition, and spelling tools to check text with and other
tools that can help translating your text into other languages.

Spelling & Grammar:
Checks spelling and grammar of your document, flags mistakes,
and suggests changes to fix the errors. Word also does some of these things
automatically, placing a red squiggly line under spelling mistakes and green squiggly
lines under grammar mistakes (although Word isn’t completely accurate at identifying
mistakes correctly).

Research: 
Uses dictionaries, encyclopedias, and bilingual dictionaries to translate a
word or sentence.

Word Count:
Counts the length of the document in number of words, characters,
paragraphs, pages, and lines.

How to print
1. Remember to save your work before
printing.
2. Click 
File 
button in upper left corner of
screen.
3. Select 
Print
from menu.
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4. Make sure your margins, orientation, and number of copies is to your liking. Also,
check the right side of the print preview to see how your printed pages will look.
5. Click
Print 
button at the top center of the print preview.
Remember: In order to print, you must have a printer attached to your computer as well
as printer software installed on the computer.

For more help and practice
In Word, click on the blue 
?
help button at the top right of the screen.
Free online help from Microsoft Office with answers to questions plus tutorials with
pictures and sound on how to use Microsoft Word 2010:
http://office.microsoft.com/enus/wordhelp/trainingcoursesforword2010HA10403904
2.aspx

Goodwill Community Foundation Word 2010 tutorials (text and videos)

15

In English: 
http://www.gcflearnfree.org/word2010
In Spanish:
http://www.gcfaprendelibre.org/tecnologia/curso/microsoft_word_2010/introduccion_a_
word_2010/1.do

